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Introduction 

The IUCN Centre for Mediterranean 
Cooperation, together with Plantlife, the 
IUCN-SSC Mediterranean Plant Specialist 
Group, and partners in several countries, are 
involved in a programme of work titled 
“Conservation of wild plants and habitats for 
people in the south and east Mediterranean”. 
This initiative aims at strengthening IPAs as 
tools for biodiversity conservation focusing on 
plant species and habitats, thereby 
contributing directly to national and regional 
decision making. 

This project focuses on Important Plant Areas 
(IPAs): sites of international importance for 
plants. IPAs are designated according to a set 
of defined criteria, based primarily on the 
occurrence of threatened species, species 
richness, and the presence of threatened 
habitats. In some regions, additional and 
alternate criteria have been developed and 
employed. 

For habitats, IPA criteria require an 
assessment of threat to be completed at a 
national or regional level, therefore requiring a 
habitat classification. As this is not available in 
many countries or regions, alternate methods 
have been used which often use expert 
opinion to identify habitat units requiring 
conservation status. 

How to translate plant species and habitat 
information into management plans that 
consider botanical values and threats remain 
a challenge. In many cases, information about 
plant species is often incomplete, and no 
national or regional habitat maps currently 
exist. To this extent, three countries (Algeria, 
Lebanon and Morocco) have selected IPAs 
where they will propose concrete measures 
for conservation of wild plants. This will 

include developing a broad classification of 
habitats and applying them to zoning and 
management planning, that including 
information on threatened species distribution. 

Habitat Mapping in Important Plant Areas 

This study is designed to propose habitat 
mapping methodologies adapted for this 
purpose in the region, and to coordinate 
training workshops to enable the national 
teams to incorporate such information into 
their work programme. 

Although this handbook describes different 
methods to achieve specific goals in different 
sections, the order in which the work 
proceeds depends upon the preference of the 
individual or project. For example, it is 
possible to define Potential Natural Vegetation 
(PNV) distributions first, and then go on to 
verify the existence and quality of habitats at 
the second stage using satellite, field or 
expert data. However, it is also possible to 
identify habitats from satellite imagery and 
expert knowledge at the first stage, create 
habitat polygons, and then compare with the 
produced PNV maps to, for example, identify 
potential areas for habitat restoration.  

Why are habitat maps necessary, and how 
to produce them. 

Visualising the spatial distribution, quality and 
quantity of resources is fundamental to 
understand ecosystems, to manage human 
activities, to deliver effective sustainable 
development and to maintain biodiversity.  

Maps have a wide range of applications in 
management, planning, policy and research 
and form an important and integral part of 
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management information systems.  The 
following are some examples of the areas 
where habitat maps can be used:  

• Provide a fundamental information layer for 
spatial and strategic planning; 

• Support sustainable use of resources; 

• Help implement an ecosystem-based 
approach to the management of human 
activities to protect the environment; 

• Prioritize monitoring effort; 

• Support the selection and optimal 
delineation of conservation areas;  

• Assess the importance, rarity and extent of 
habitats over local, regional, national and 
international scales; 

To produce maps and analyse data in a 
spatial context, GIS (Geographical Information 
System) is used. This is a computer system 
that provides the function and tools needed to 

assemble, store, manipulate, display and 
compare large amounts of geographical 
information. Maps stored in GIS can be 
updated to reflect change in attributes, such 
as land-use or boundaries. 

Definition of “habitat” 

The term ‘habitat’ is frequently used in policy 
instruments and more widely in the scientific, 
policy and environmental management 
communities. Consequently, it has many 
definitions that can lead to confusion.  

The term “habitat” used within this document 
refers to a homogeneous biological 
community / vegetation supported by common 
environmental conditions. This definition has 
been kept broad, in order that different 
countries can define their own habitat 
boundaries that correspond to appropriate 
management and other country-specific 
policy. 
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Practical Habitat Mapping using QGIS 
software 

In this exercise, habitat maps will be produced, 
verified and assessed, and species occurrence 
data included, using QGIS software and free 
spatial data available online. 

QGIS is a user friendly Open Source 
Geographic Information System (GIS) licensed 
under the GNU General Public License: 
http://www.qgis.org/en/site/about/index.html 

The version used during the workshop is QGIS 
2.12. You will find the latest version of QGIS to 
download on the website: 
http://download.qgis.org 

All QGIS documentation, including “User Guide” 
and “Training Manual” can be found on the 
QGIS documentation website: 
http://www.qgis.org/en/docs/index.html 

All GIS information are not covered by the 
current document, only the specific steps 
realised during the workshop and necessary to 
perform the habitat mapping methodology are 
presented. Please refer to the User Guide for 
more specific details about the features and 
functions of QGIS. 

The habitat mapping and other steps presented 
here require the installation of several plugins: 

Processing: a spatial data processing 
framework for QGIS 

OpenLayers Plugin: to open OpenStreetMap, 
Google Maps, Bing Maps or more 

Group Stats: to perform statistics and analysis 
for vector layers data 

You can manage your plugins in the plugin 
dialog which can be opened with Plugins > 
Manage and install plugins ... The Plugins 
dialog allows the user to install, uninstall and 
upgrade plugins. Select the plugin and use 
Install plugin. 

Coordinate reference system 

It is very important that all layers used and 
created in QGIS use the same coordinate 
reference system, otherwise the different layers 
will not be comparable to each other spatially. 
There are more details at the following 
webpage: 

http://docs.qgis.org/2.8/en/docs/user_manual/w
orking_with_projections/working_with_projectio
ns.html 

  

http://www.qgis.org/en/site/about/index.html
http://download.qgis.org/
http://www.qgis.org/en/docs/index.html
http://docs.qgis.org/2.8/en/docs/user_manual/working_with_projections/working_with_projections.html
http://docs.qgis.org/2.8/en/docs/user_manual/working_with_projections/working_with_projections.html
http://docs.qgis.org/2.8/en/docs/user_manual/working_with_projections/working_with_projections.html
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Section One 

Habitat Mapping using Satellite Imagery 

Objectives 

In this section, knowledge about the habitats and vegetation 
types held by experts with detailed experience of particular 
sites and regions will be described in QGIS, so that this 
information is captured spatially and can then be used in a 
variety of analyses, presentations or management options. 

Essentially, this section allows the user to view satellite 
images, and create “polygons” that represent different 
habitats or areas of interest within an IPA. 

At a later stage, these polygons can be compared based 
upon data held within them (for example, species occurrence 
data), and zoning plans for features and habitats of interest 
created. 

This process is analogous to drawing lines on maps, but with 
the advantage of allowing a range of different data of interest 
to be integrated and updated in a series of spatial layers. 

 

We propose the following methodology:  

1. Acquire existing spatial layer (spatial images) using 
open access data and use IPA boundaries to set the scale 
of the study. 
2. Delineate broad habitat units from homogeneous 
vegetation type using satellite images.  
3. Defined and named broad habitat units from expert 
knowledge. Assess whether the information on habitat are 
enough or if additional field survey is required. 

As new data becomes available (field survey, additional 
expertise) the process can be updated. 

  



  

Page | 6 

 

1.1  Add and Manipulate Layer 

Objective: The objective of this stage is to add and clip layer to limit them to the project scale. This is 
done by integrating a specific boundary layer, for example a country boundary or an IPA boundary. 

QGIS recognizes two types of data: vector data and raster data. Boundaries are commonly vector files 
(lines or polygons), and the standard vector file format used in QGIS is the ESRI shapefile (.shp).  

Step 1: to load a shapefile, start QGIS, click on the Add Vector Layer toolbar button (there are also 

drop down menu or shortcut options). From the available options tick File. Click on Browse to 
navigate to the file you want to open and click Open to load it into QGIS (see Figure 1.1.1). The result 
is shown in Figure 1.1.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.1.1. Steps to load Vector Layer into QGIS.  

http://docs.qgis.org/testing/en/_images/mActionAddOgrLayer.png
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Figure 1.1.2. Vector Layer containing the boundary of the Sierra de las Nieves Natural Park.  

  



  

Page | 8 

 

Step 2: to change the appearance of the vector file you have just loaded (your file is now a layer in the 
project), double click on the name of your file in the layer panel on the left of the QGIS desktop. This 
allows you to alter the display properties of the layer, for example to change the styles (the colour, 
symbology, shading and transparency of the boundary loaded) or add labels. (Figure 1.1.3).  

 

 

 

Figure 1.1.3. Dialog box from where you can change the display properties of the vector layer. 
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Step 3: to zoom to a particular layer (e.g. to allow the entire boundary to be scaled to fit onto the 
screen in its entirety), right click on the layer and select Zoom to Layer (Figure 1.1.4). 

You can also use the mouse wheel to zoom in and out of the map view. 

 

 

 

Figure 1.1.4. Drop-down menu to zoom to the layer selected.  
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1.2 Load satellite image 

Objective: Satellite imagery combined with GIS is an essential tool for habitat mapping. Google Maps 
Satellite can be opened directly in QGIS and is free and easy to use. This stage describes how to 
open and view satellite images directly in QGIS.   

Step 1: Click on Web > OpenLayers Plugin > Google Maps > Google Satellite. 

 

 

 

 

 

 

 

 

 

 

Figure 1.2.1. Steps to open satellite imagery in QGIS. 
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Step 2: in order to be able to see the vector layer containing the boundary of the Sierra de las Nieves, 
it is necessary to move that layer to the top of the list of layers on the left of the screen. The top layer 
is the most visible layer. 

 

 

Figure 1.2.2. This image shows Google Maps Satellite open, with the boundary shapefile of the Sierra 
de las Nieves. The boundary has been changed to white, and the “fill” changed to transparent so that 
the satellite image can be viewed directly.  
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1.3  Create vector file 

Objective: a habitat map is basically a vector file made of a complete coverage of polygons 
representing the different habitats or other features of interest. This stage shows how to create a 
vector file. 

Step 1: to create a new shapefile layer, Choose  New Shapefile Layer on the toolbar. The New 

Vector Layer dialog box will be displayed. Choose the type of layer  Polygon. Under New 
attribute, type a name 10 characters long maximum, increase the width of the character string to 
allow longer names, click on Add to attribute list. You can add several attributes at this stage. For 
example, you may consider adding at least two or three different hierarchies of habitat attributes. A 
broad habitat attribute will allow you to visualise together one broad habitat class (example “forest”), 
and a more specific habitat one to visualise separately the “Abies forest” and “oak forest” for example. 

When all attribute are added, click OK. You will be prompted to the Save layer as… dialog box. 
Browse to the location you want to save the file, type the file name (in this example “Habitat01-SdlN”) 
and click Save. You will be able to see the new layer in the Layers list. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.3.1. Dialog box options to create a new vector file.  
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1.4  Create a polygon 

Objective: to delineate the broad habitat units, it is necessary to create polygons encompassing 
homogeneous types of vegetation observed using the satellite images and based upon the expert 
knowledge of project partners. This stage explains how to create individual polygons. 

Step 1: Click on the layer name to select the layer you have just created. All editing sessions start by 

choosing the Toggle editing option. Now, click on the Add Feature icon (or select Edit → 

Add Feature). When you do this, the cursor will look different (not an arrow head). Left-click on the 
map area to create the first point of your new feature. Keep on left-clicking for each additional point 
you wish to include in your polygon. When you have finished adding points (i.e., the polygon 
represents one habitat area), right-click anywhere on the map area to confirm you have finished 
entering the geometry of that feature. The attribute window will appear. Input the ID name you want for 
your polygon (e.g.,"1"), then name the “broad habitat” from the satellite image (e.g. forest, woodland, 
grassland etc.) , add the “specific habitat” name if you know it and all the information for the different 

attribute created in the step 1.3., then click OK. To save the new polygon, click on Save Layer 

Edits (either on the toolbar or under the Layer menu) as in Figure 1.4.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.4.1. Add a new feature, add data to the new polygon attribute window and save the change 
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Figure 1.4.2. Example of two separate areas (in green) of habitat drawn as polygons.   
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1.5  Editing vector layers 

Objective: this stage introduces different tools used to edit the layer (and polygons) you create. 

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if 
there is a slip of the mouse. Once polygons are created, there is several ways to modify them.  

All editing sessions start by choosing the Toggle editing option.  

Remember to Save Layer Edits regularly. 

Many of these tools might be used for habitat mapping using polygons, and it is useful to be aware of 
their functions. To get more information about these tools:  

https://docs.qgis.org/2.2/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html 

 

Icon   Purpose Icon Purpose 

 

Current edits 
 

Toggle editing 

 

Adding Features: Capture Point 
 

Adding Features: Capture Line 

 

Adding Features: Capture Polygon 
 

Move Feature 

 

Node Tool 
 

Delete Selected 

 

Cut Features 
 

Copy Features 

 

Paste Features 
 

Save layer edits 

 

Undo 
 

Redo 

 

Rotate Feature(s) 
 

Simplify Feature 

 

Add Ring 
 

Add Part 

 

Fill Ring 
 

Delete Ring 

 

Delete Part 
 

Reshape Features 

 

Split Parts 
 

Split Features 

 

Merge Attributes of Selected Features 
 

Merge Selected Features 

 

https://docs.qgis.org/2.2/en/docs/user_manual/working_with_vector/editing_geometry_attributes.html
https://docs.qgis.org/2.2/en/_images/mActionSaveEdits.png
https://docs.qgis.org/2.2/en/_images/mActionAllEdits.png
https://docs.qgis.org/2.2/en/_images/mActionToggleEditing.png
https://docs.qgis.org/2.2/en/_images/mActionCapturePoint.png
https://docs.qgis.org/2.2/en/_images/mActionCaptureLine.png
https://docs.qgis.org/2.2/en/_images/mActionCapturePolygon.png
https://docs.qgis.org/2.2/en/_images/mActionMoveFeature.png
https://docs.qgis.org/2.2/en/_images/mActionNodeTool.png
https://docs.qgis.org/2.2/en/_images/mActionDeleteSelected.png
https://docs.qgis.org/2.2/en/_images/mActionEditCut.png
https://docs.qgis.org/2.2/en/_images/mActionEditCopy.png
https://docs.qgis.org/2.2/en/_images/mActionEditPaste.png
https://docs.qgis.org/2.2/en/_images/mActionSaveEdits.png
https://docs.qgis.org/2.2/en/_images/mActionUndo.png
https://docs.qgis.org/2.2/en/_images/mActionRedo.png
https://docs.qgis.org/2.2/en/_images/mActionRotateFeature.png
https://docs.qgis.org/2.2/en/_images/mActionSimplify.png
https://docs.qgis.org/2.2/en/_images/mActionAddRing.png
https://docs.qgis.org/2.2/en/_images/mActionAddPart.png
https://docs.qgis.org/2.2/en/_images/mActionFillRing.png
https://docs.qgis.org/2.2/en/_images/mActionDeleteRing.png
https://docs.qgis.org/2.2/en/_images/mActionDeletePart.png
https://docs.qgis.org/2.2/en/_images/mActionReshape.png
https://docs.qgis.org/2.2/en/_images/mActionSplitParts.png
https://docs.qgis.org/2.2/en/_images/mActionSplitFeatures.png
https://docs.qgis.org/2.2/en/_images/mActionMergeFeatureAttributes.png
https://docs.qgis.org/2.2/en/_images/mActionMergeFeatures.png
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1.6  Layer Attribute Table 

Objective: this stage introduces the Layer Attribute table, which contains information held within the 
layers you create and load. Within the attribute table, attributes and information can be modified and 
statistics on attribute calculated, and will be used to assist the classification at later stages. 

Step 1: right-click on the layer in the left hand layers panel, then select open attribute table from the 
drop-down choices. A dialogue box opens, it is the attribute table.  Notice the top row contains the 
attribute/field names (COLUMN name), and each ROW contains the information for those fields for 
every polygon. One ROW = one spatial feature (in this case polygon) in the chosen layer. 

 

 

Figure 1.6.1. Open the attribute table of a vector layer.  
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Step 2: Select a single feature / polygon by clicking on the row number at the left side of the Attribute 
Table. The selected row will be highlighted. Move your cursor over the selection options along the top 
of the Attribute Table. 

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the 
set of features selected in the main window is changed, the selection is also updated in the attribute 
table. Likewise, if the set of rows selected in the attribute table is changed, the set of features selected 
in the main window will be updated. 

Rows can be selected by clicking on the row number on the left side of the row. 

The other buttons at the top of the attribute table window provide the following functionality: 

 Toggle editing mode to edit single values and to enable functionalities described below  

 Save Edits  

 Unselect all  

 Move selected to top  

 Invert selection  

 Copy selected rows to clipboard  

 Zoom map to the selected rows  

 Pan map to the selected rows  

 Delete selected features  

 New Column  

 Delete Column  

 Open field calculator  

 

 

 

 

 

 

 

 

  

https://docs.qgis.org/2.2/en/_images/mActionToggleEditing.png
https://docs.qgis.org/2.2/en/_images/mActionSaveEdits.png
https://docs.qgis.org/2.2/en/_images/mActionUnselectAttributes.png
https://docs.qgis.org/2.2/en/_images/mActionSelectedToTop.png
https://docs.qgis.org/2.2/en/_images/mActionInvertSelection.png
https://docs.qgis.org/2.2/en/_images/mActionCopySelected.png
https://docs.qgis.org/2.2/en/_images/mActionZoomToSelected.png
https://docs.qgis.org/2.2/en/_images/mActionPanToSelected.png
https://docs.qgis.org/2.2/en/_images/mActionDeleteSelected.png
https://docs.qgis.org/2.2/en/_images/mActionNewAttribute.png
https://docs.qgis.org/2.2/en/_images/mActionDeleteAttribute.png
https://docs.qgis.org/2.2/en/_images/mActionCalculateField.png
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Section Two 

Potential Natural Vegetation 

Objective: 

Potential Natural Vegetation (PNV) mapping 
refers to the vegetation expected in an area 
given certain environmental constraints, 
originally developed by German vegetation 
scientist Reinhold Tüxen (1956). PNV can be 
calculated and estimated by using freely 
available environmental data, and classifying 
it into classes that correspond to 
environmental conditions that support 
particular vegetation or other features. It does 
not take into account human modification of 
habitats, and therefore can be used not only 
as a comparison with contemporary land use 
through satellite imagery, but also to predict 
potential suitable area s for restoration 
programmes. 

Ideally, PNV maps will be verified through 
field surveys. This could encompass full scale 
vegetation analyses as well as taking into 
account fine scale environmental features 
such as small areas of specific substrates or 
physical features such as cliffs. Field survey 
of vegetation and species can also determine 
the comparative botanical richness, and 
identify if there are distinct vegetation units 
that are not identified through PNV mapping.  

This section will describe a simple method to 
define a PNV map in the Mediterranean 

region using freely available data. It makes 
use of the fact that plant and vegetation 
distribution is largely a function of specific 
variables in climate and environmental 
factors. The specific range for each of these 
variables corresponds to a particular 
vegetation class. The proposed method has 
been verified through comparison with the 
vegetation map of Andalucía. While the PNV 
of Andalucía may not be the same as that in 
other Mediterranean countries, the verification 
conducted showed the validity of the 
methodology, rather than attempting to 
replicate existing vegetation units. The 
different bioclimatic and environmental 
variables present in other Mediterranean 
regions will result in vegetation classes 
corresponding to those regions. 

The cut-off points for data on precipitation, 
altitude and temperature that delineated 
vegetation type was used. For example, from 
a possible 150 distinct PNV classes, eight 
were identified within the Sierra de las Nieves. 
These eight classes may or may not be 
represented in other regions or territories, and 
novel combinations will be present in other 
regions and territories due to differences in 
climate and environment between those 
regions.
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Figure 2.0. Conceptual diagram of the PNV method and when to associate additional data to the map. 
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2.1  Add raster layer 

Objective: while vector layers most often contain points, lines and polygons, raster layers are composed 
of a grid, each cell of which contains a value (like the pixel of the image). In this stage, loading existing 
raster layers into QGIS is described. 

In the example covered during the workshop, we added Precipitation, Altitude and Temperature in order 
to delineate area of similar environmental conditions that represent the potential natural vegetation of 
Andalucía and check the success of the methodology. All three variables are stored as image file 
(raster) and can be added to the project. At a later stage they will be combined and classified. 

Step 1: Open QGIS, raster layers are loaded either by clicking on the Add Raster Layer icon or by 

selecting the Layer >  Add Raster Layer menu option. 

Browse to the directory containing the environmental variables required (in this case altitude, 
precipitation, and temperature), click on the image files to make a selection, and click Open. Repeat this 
for each of the three variables required to load three raster layers into QGIS. 

 

           

Figure 2.1.1. Selecting Add Raster Layer option from the drop down menu of Layer.  

https://docs.qgis.org/2.2/en/_images/mActionAddRasterLayer.png
https://docs.qgis.org/2.2/en/_images/mActionAddRasterLayer.png
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Figure 2.1.2. This image shows the raster layer for Altitude loaded into QGIS. The Layers Panel on the 
left shows all three raster layers present. 
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2.2  Add vector layer 

Objective: This stage describes how to add a vector layer and how to use this vector layer to remove 
unwanted data that occurs outside the project scale. 

Step 1: to load a shapefile, start QGIS, click on the Add Vector Layer toolbar button (there are also 

drop down menu, see figure 2.2.1 or shortcut options). From the available options tick File to 
indicate you will load a pre-existing file as your data source. Click on Browse to navigate to the file you 
want to open and click Open to load it into QGIS (see Figure 1.1.1). 

 

 

Figure 2.2.1. Window and dialog box showing how to open a vector layer in QGIS. 

http://docs.qgis.org/testing/en/_images/mActionAddOgrLayer.png
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Figure 2.2.2. This image shows the vector layer containing the boundary of the Sierra de las Nieves on 
top of the raster layer for altitude. The window is zoomed to the vector layer. The boundary colour and 
fill have been altered as described previously (section 1.1 steps 2 and 3), to allow the raster layer to be 
visualized. 
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2.3 Clip raster layer 

Objective: the objective of this stage is to remove information outside the area of interest using the 
vector layer as the boundary. 

Step 1: Go to Raster > Extraction > Clipper 

Select the input file (raster). Then select the location and the name of the output file, for this, click on 
Selection ..., browse to an appropriate location, at the bottom of the window enter the file name in the 

file name, click save to finish. Back in the previous dialog box, choose  Mask layer as Clipping 
mode. Select the vector layer (in this case, Sierra de las Nieves boundary layer) as the mask layer. Tick 
the box next to Load into canvas when finished. Click OK 

 

This needs to be done for each of the environmental attributes separately – in this case, there are three. 

 

 

     

Figure 2.3.1. Menu and dialog box selections to clip a raster layer relative to the vector layer.  
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Figure 2.3.2. This image shows the Andalucía Altitude layer clipped within the Sierra de las Nieves 
Natural Park boundary. The new layers created can be seen in the left hand layers panel. 
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2.4  Polygonize: raster to vector layer 

Objective: as raster data and associated are harder to use, it is necessary to convert them to vector 
layers so the information can be treated as it will be with polygons. 

Step 1: Go to Raster > Conversion > Polygonize 

Select the input file (raster). Then, as in the previous step (2.3.1) select a location and a name for the 
output polygons file. Tick Load into canvas when finished, and then click OK 

. 

This needs to be repeated for each of the three environmental attributes. 

 

 

 

Figure 2.4.1. Menu and dialog box options to convert a raster layer to a vector layer. 
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Figure 2.4.2. This image shows the Sierra de las Nieves Altitude layer converted to a vector layer. 
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2.5  Classifying: field calculator 

Objective: in this stage the limits for classes within each environmental variable will be set to define 
bioclimatic and environmental conditions that support different broad natural vegetation types in the 
Mediterranean region. This must be done separately for each of the three variable in vector layers. 

Step 1: In the left hand side layer panel, right click on the vector layer to classify, in the drop-down 
menu select Open attribute table 

Within the attribute table, click on  open field calculator 

 

 

Figure 2.5.1. Menu options to open the attribute table and the field calculator.  

https://docs.qgis.org/2.2/fr/_images/mActionCalculateField.png
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Step 2: Tick Create a new field. Enter your chosen Output field name, and change the output field type 
to text (=Class), and lengthen the field width to 30 characters 

In the expression field, copy and paste the text below within the field calculator of the attribute table of 
the three environmental variables, then select OK. See Figure 2.5.2 as an example of what this should 
look like once completed. 

 

For precipitation: 

CASE  

  WHEN  "DN" <100 THEN '1' 

  WHEN  "DN" <400 THEN '2' 

  WHEN  "DN" <600 THEN '3' 

  WHEN  "DN" <800 THEN '4' 

  WHEN  "DN" <1200 THEN '5' 

  WHEN  "DN" >=1200 THEN '6' 

END 

 

For altitude: 

CASE  

  WHEN  "DN" <400 THEN '1' 

  WHEN  "DN" <1000 THEN '2' 

  WHEN  "DN" <1500 THEN '3' 

  WHEN  "DN" <2000 THEN '4' 

  WHEN  "DN" >=2000 THEN '5' 

END 

 

For temperature: 

CASE  

  WHEN  "DN" <40 THEN '5' 

  WHEN  "DN" <80 THEN '4' 

  WHEN  "DN" <130 THEN '3' 

  WHEN  "DN" <170 THEN '2' 

  WHEN  "DN" >=170 THEN '1' 

END 
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Figure 2.5.2. Field calculator dialog box, with text for Precipitation added. 

  

Figure 2.5.3. After creating a new in field step 2.5.2., the attribute table presents a new column named 
Class.  
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2.6  Combine similar features 

Objective: within each environmental variable, different features will have the same class as defined in 
stage 2.5. In this stage, the similar feature will be grouped together so they are treated as a single class, 
despite not being adjacent. Again, this must be done for each of the three variables separately. 

Step 1: Go to Vector > Geoprocessing tools > Dissolve 

Select the input file (vector). Choose dissolve field (feature to combine). Give the Output file a name. 
Tick the box next to Load into canvas when finished, then click OK. 

 

 

 

Figure 2.6.1. Menu and dialog box options for the Dissolve tool. 
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Figure 2.6.2. This image presents the vector layer precipitation dissolved by class. Again, the dissolved 
classes are not classified by colour, the map does not change. However, the attribute table of this new 
vector layer change, the feature number is now equal to the number of class.  
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2.7  Assemble = overlay 

Objective: in this stage, the three different environmental variables are combined into a single layer 
which contains the combined attributes of all three variables. As there are six classes in Precipitation, 
five classes in Altitude and five classes in Temperature this gives a total of 150 possible combinations. 
Each of these combinations represents a PNV category. This combination can only be done one pair at 
a time, so it is necessary to combine two dissolved pairs, then select this new combined layer and 
combine it with the third dissolved variable. 

Step 1: Go to Processing > Toolbox. The toolbox will open on a new panel on the right side. Check 
that the drop-down menu at the bottom of the panel indicates Advanced interface. Open the drop-
down menu> GRASS commands, then Vector (v. *) and V.overlay (double click). A dialog box opens 

Select the input layer (A) and (B) - two of the classified environmental variable vector layers. Select 
input layer type as area and select operator to use as and. Click Run. 

 

Figure 2.7.1. Drop-down Menus used to open the “overlay” function. 
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Figure 2.7.2. Dialog box options for overlaying pairs of environmental attributes.  
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Step 2: repeat the above procedure selecting the two input layers as (a) the newly created combined 
layer featuring two variables, then (b) adding the third variable. The resulting file will contain data from 
all three environmental variables, and will be used for the final classification of PNV. Make sure to name 
this file so that it is recognisable as the final layer with all three variables combined. 

Files created from the overlay option are temporary files; at this stage make sure to save the final 
combined layer. Right-click on the layer, then select Save as … from the drop-down choices, select 
ESRI Shapefile as format, browse the directory to find a location (as previously done) and give it an 
output name. 

 

 

Figure 2.7.3. Screenshot showing the overlay vector layer that has combined the dissolved altitude and 
precipitation layers. This creates a new layer called “overlay”. Selecting this overlay and combining it 
with the third variable (in this case temperature) as in 2.7 step 1 above will result in another “overlay” 
vector layer containing data from all three variables. 
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2.8  Classify 

Objective: in this stage, the distinct PNV classes are named, classified and coloured individually. This is 
done by first adding a new field to the table to include a name for the PNV class, using a string of text to 
instruct the classification. Save the output file containing the classes identified in our area of interest. 
Then modify the properties of the file to change colour as seen in 1.1 step2. 

Step 1: Right click on the Overlay vector layer containing all three variables combined (in the menu on 
the left side) and open the Attribute table. Open the field calculator as done previously (button on far 
right). 

Step 2: Tick Create a new field. Enter your chosen Output field name, and change the output field type 
to text (=Class), and lengthen the field width to 30 characters. 

In the expression field, copy and paste the text below. For X, Y and Z, replace with the column title that 
corresponds to the environmental variable attribute class input at stage 2.5 and insert inside quotation 
marks “_”. This can also be done by highlighting the column header text, then selecting that column 
header from the drop down menu as shown in Figure 2.8.1.  

The text in red in the example represents the columns headings that correspond to the attribute values 
in this example screenshot.  

Example: concat('Alt',X,'Temp',Y,'Prec',Z) 

Example: concat('Alt',“a_a_ALT”,'Temp',“b_TEMP”,'Prec',“a_b_PREC”) 

Select OK. 

 

 

Figure 2.8.1. Menu and dialog box options to obtain the PNV distinct classes.  
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Figure 2.8.2. Result of the step 2.8.2., the attribute table of the overlay layer has an additional column 

including the PNV classes.  
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Step 3: Right click on the classified layer in the left hand menu and choose properties. From the drop 

down menu at the top of the dialog box, select categorized, then choose the classes’ column as 

column, random colours for the colour ramp and finally classify at the bottom, OK. It will colour the 

different PNV class in different colour. 

 

 

Figure 2.8.3. Dialog box options to colour PNV classes independently. Select Categorize. 
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Figure 2.8.4. Image showing PNV classes based upon the classification of the variable altitude, 
precipitation and temperature within the Natural Park of Sierra de las Nieves. Eight different classes are 
represented within the boundary.  
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2.9  Compare to satellite imagery 

Objective: in this stage, you can add satellite imagery to compare actual land use with PNV classes. 
This requires loading Google Satellite maps, then changing the transparency of the PNV classes. 

Step 1: to change the transparency of each class to 25% of the original map so the satellite images can 

be viewed through the PNV classes, open the dialog box Layer property (see 2.8 step 3), in the 

rendering of the bottom layer of the dialog box, change the transparency of the layer to 75%. 

Step 2: To load the satellite image (see section 1.2) or Web > OpenLayers Plugin > Google Maps > 
Google Satellite  

 

 

Figure 2.9.1. Image showing PNV classes converted to transparent colours, through which satellite 
imagery can be viewed.  
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Section Three 

Species Occurrence Data 

Objectives: 

IPAs can be designated not just for rare or 
threatened habitats, but also for botanical 
richness (species richness in a given habitat) 
or for rare and threatened species globally, 
regionally and nationally. Adding species 
occurrence data into zoning plans at an IPA 
scale is rarely done. However, such data 

allows prioritization within and between IPAs 
in order to concentrate conservation 
resources to maximum effect to conserve 
threatened species and the ecosystem 
services they provide. This Section describes 
how to add species occurrence data to spatial 
layers, and extract data depending on the 
habitat polygon defined by the user.
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3.1  Add point record data 

Objective: This stage describes how to add species occurrence data into QGIS. Data can be added 
and then saved as a vector file. The data should be uploaded from a Comma Separated Value (.csv) 
spreadsheet. Remember to include all data that may be relevant in columns – for example species 
name, threatened status, endemic status, and latitude and longitude geographic coordinate reference. 
The following stages will allow this information to be retrieved for separate polygons that might 
represent habitat or other land use characteristics. 

Step 1: To load a point record table, click on the  Add Delimited text layer toolbar button. Click on 

Browse, which will bring up a standard open file dialog box, which allows you to navigate the file 

system and load a .csv file, and clicking Open loads it into QGIS. Define the delimiters as .csv. For 

the Geometry definition tick  point coordinates and selects columns from the drop down menu for 
X (longitude) and Y (latitude) fields. Click OK (Figure 3.1.1).  

 

 

Figure 3.1.1. Menu and dialog box options to add species occurrence data from a .csv spreadsheet. 
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Step 2: To save the layer containing the point record as a vector file (shapefile, .shp), right-click on the 
layer, then select Save as … from the drop-down choices, select ESRI Shapefile as format, browse the 
directory to find a location (as previously done)and give it an output name (e.g. “habitat-record-Sierra”). 

 

 
 

Figure 3.1.2. Menu and dialog box to save point record as a shapefile. 
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3.2  Visualizing point record data information 

Objective: for each point record, it is possible to visualize the data associated with it, for example, which 
habitat types it is classified in, or the name the species if it is a species occurrence record. 

Step 1: Identify features allows us to interact with map canvas to get data of the feature on a panel 
called Identify results on the left of the window. To identify feature select the point record vector layer 

just created, click on the Identify features in the toolbar, then click on the point data on the map 

screen that you want to know about. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.2.1. Identify a point record and associated data readable in the Identify panel.  

http://docs.qgis.org/2.0/uk/_images/mActionIdentify.png
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3.3  Species record per habitat 

Objective: In this section, we will output a list of records in our areas of interest. We will output a file that 
shows all records, the output file will classify each record as to the area it can be found in. Therefore, we 
can sort the resulting file into species or areas. Two examples are used one with the result of the PNV 
method and one with the two habitat polygons in green, and species occurrence data are from the open 
access database GBIF. 

The success of this depends on (a) the hierarchical levels of classification you define when you draw 
polygons and name them, and (b) the data contained in your record input file. The latter should include 
not only species name and georeferenced coordinates, but also other information of use such as 
threatened status, endemic or not. In that way, all information can be sorted by polygon, giving the 
power to locate species of conservation interest in different habitats and zones within an IPA. 

 

Step 1: Go to Vector > Geoprocessing tools > Clip… 

Select the input file (species occurrence record shapefile). Choose clip layer (habitat polygons layer or 
PNV layer). Select a location and name the Output file as previously done. Click OK. 
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Step 2: Go to Vector > Geoprocessing tools > Union… 

Select the input file (newly clipped species occurrence record shapefile). Choose union layer (habitat 
polygons layer or PNV layer). Select a location and name the Output file as previously done. Click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.3.1. Menu and dialog box to join (union) the species record data with the PNV classes. 
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Figure 3.3.2. This screenshot shows the attribute table of the new union layer, the rows correspond to 
the point record, notice the last two columns of the Attribute table corresponding to polygon data the 
record occurred in.  
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Step 3: Go to Vector -> group stats-> GroupStats 

 

Figure 3.3.3. Drop-down menu used to open GroupStats. 
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Step 4: In the control panel, select in the drop down menu of Layers the previously created Union layer 
(step 3.3.1) Within Fields: Select the PNV class field name and drag it to the Row box (example Figure 
3.3.2, name= TPA), select the species scientific name and drag it to the Columns box (example name= 
scientific) and drag the field unique and species for Value. Then click on Calculate  

A table appear on the left of the Group Stats dialog box, click on Data, then Save all to CSV file, to 
save the floristic table (presence of species occurrence data per PNV class). 

 

Figure 3.3.4. Group Stats dialog box to create the table species occurrence data per PNV class. 
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3.4 Field survey 

Objective: The amount of data available on open access databases such as GBIF varies enormously 
from country to country. Therefore, to acquire distribution data about known species of conservation 
interest will require additional fieldwork. 

These data can be compiled in .csv spreadsheets and added to your habitat mapping project the same 
way as described in section 3. These can then be extracted and added to habitat maps and 
incorporated into zoning for prioritization.  
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Section Four 

Zoning 

Objective 

It can be beneficial to split an IPA or other 
Protected Area into small and manageable 
units, and to apply various management 
options to these units. This can be to prioritise 
areas which are rich in species, contain 
significant numbers of threatened or endemic 
species, or contain particular good examples 
of pristine habitat. It can also be to constrain 
certain activities in different areas that would 
otherwise be damaging to the features of the 
IPA requiring conservation. 

This section gives several zoning options, and 
points to above sections that can be used to 
achieve such zoning measures. 

4.1 Habitat quality 

As many habitats have become degraded 
over time, conservation targets often prioritise 
existing habitats that are in good condition – 
for example, they show little or no signs of 
degradation and retain their component 
species. Degraded habitats will show obvious 
signs of human intervention, and may be less 
diverse in terms of species, or may include 
invasive species. Giving habitat quality scores 
to different areas within an IPA can help to 
prioritize actions and conservation measures: 
these zones may have different rules applied 
to them. For example, certain activities may 
be restricted within high quality habitats, 
whereas they may be allowed in lower quality 
habitats.  

Habitat quality can be ascertained through 
expert knowledge of the sites themselves, or 

by using satellite imagery, or in the absence 
of expert knowledge field surveys comparing 
similar habitats in different areas can be 
undertaken. 

In a complete lack of expertise, data or 
knowledge, PNV maps can be compared to 
satellite or field survey data to ascertain which 
areas of potential habitat still remain intact. 

Habitat quality value can be added to the 
attributes table of polygon defining these 
habitats (by adding a column in the attribute 
table, see section 1.4 to 1.6). 

High quality habitats or those at least threat 
from anthropomorphic activities can be 
prioritized, and protected by buffer zones (see 
4.5) or though prescriptive measures 
identified on the ground 

4.2 Threats 

Many threats affecting plants and habitats can 
be discerned. Some of these threats will be 
identified and it is possible to delineate some 
areas particularly affected by human activities 
within IPAs through satellite image or by 
downloading some specific GIS layers (land 
use, urbanization etc.). This includes roads, 
habitations, agricultural expansion or other 
anthropogenic uses (quarries, industrial units 
etc.).  

The identification of these threats is essential 
to suggest efficient and specific conservation 
actions to limit such activities in high priority 
areas in order to preserve wild species and 
habitats. 
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Figure 4.1. IPA boundary of the National Park of Gouraya (Algeria). 

 

The example of the National Park of Gouraya 
IPA (Figure 4.1) shows clearly the presence 
within its boundary of urban area, and also a 
major quarry located in the north central area. 
There are also access roads and tracks 
visible. Zoning might identify remaining high 
quality habitats and the occurrence of 
threatened or endemic species, and restrict 
further anthropomorphic activities within them. 
It is also possible to restrict activities in a 
barrier around high quality habitat areas, in 
order to restrict impact to further distances 
away from fragile habitats. 

These threats directly related to human 
activities modifying the habitat can be 
delineated as polygons using QGIS, and to be 
implemented in the management plans.  

 

 

4.3 Habitat zoning 

As habitats refer to a homogeneous biological 
community / vegetation supported by common 
environmental conditions, habitats usually 
host a number of different species. How many 
of these species are threatened or endemic? 
What ecosystem services do they provide? As 
for the threats and quality of habitat, this 
information must be collected and added into 
the habitat maps in GIS as described in 
Section One and Section Three. All this data 
will have a significant impact on zoning plans, 
especially to demonstrate which habitat areas 
are of high priority. 

4.4 Species Occurrence data 

Using the methods of the Section Three, the 
species occurrence data can be added to the 
spatial layers. Although the habitats of high 
quality are likely to contain more endemic 
species, low quality habitats are more likely to 
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contain endangered species that are  threaten 
by human activities or low quality of the 
habitat itself. 

Coupling the species-occurrence data with the 
polygons that contain information about land 
use and threats using methods of the first and 
third parts are therefore interesting to. This 
will give information to prioritize actions to 
conserve such species. 

4.5 Buffer Zones 

Above it has been mentioned that certain 
actions could be restricted, depending on 
proximity to threats or the presence of species 
of conservation importance.  In nature 
conservation, a buffer zone is often created to 
enhance the protection of areas under 

management for their biodiversity importance. 
A buffer zone is a spatial area and zoning tool 
that lies between a highly valuable zone and 
the menace to protect and limit the harmful 
human actions, it will segregate the high 
priority zone. 

It should be remembered that, while habitat 
units can be identified without field work at a 
broad scale using the methods above, 
species occurrence data, zoning plan or the 
description of buffer zones cannot be 
complete described upon limited data. 

As well as zoning, all management plans 
should contain detailed additional data to fully 
understand and conserve wild plants and 
habitats for and with people within IPA. 
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Section Five 

Field Survey 

The best way to accurately identify and classify 
contemporary habitats and vegetation classes 
is through detailed and extensive field survey. 
We always recommend that habitat mapping is 
achieved through field survey. However, this 
can be very time consuming, hence the 
description above of methods using satellite 
imagery, expert knowledge and PNV mapping 
which can be achieved efficiently and at less 
expense. 

In the absence of expert knowledge about the 
habitats, vegetation and taxa in a given area, 
field survey will still be required. This can be for 
a number of reasons: 

 Detailed information on the distribution and 
occurrence of threatened or endemic 
species. 

 Formal vegetation classification that 
cannot be predicted accurately through 
PNV mapping. 

 Habitat quality assessments and threats. 

 Mapping small or unique habitats that are 
difficult to assess via satellite imagery, for 
example cliff vegetation or freshwater 
habitats. 

To include species occurrence data relating to 
threatened or endemic taxa, these data should 
be georeferenced in the field and incorporated 
into habitat maps using the methods described 
in Section Three of this handbook. 

Field surveys should be used to mark / name 
the polygons representing habitats created 
using the methods described in section one of 
this handbook, to establish the quality of habitat 
and threats. Also they are a great help to refine 
the limits of these polygons or delineate the 
small but unique habitats difficult to identify 
from satellite images or PNV classification. 

The annex II shows an example of a simple 
survey form that can be used to record 
information of this type. It includes space to 
record site specific information, as well as 
details about habitats observed and the level of 
degradation. Data on the presence and 
abundance of plant species can be used in 
formal analyses to distinguish among distinct 
vegetation types, and to categorise them by 
their characteristic taxa. The methods to do this 
are beyond the scope of this handbook. 

For record keeping, we recommend the use of 
panoramic photography at fixed reference 
points as a record of habitat quality and 
monitoring. Such reference points should be 
located via GPS and extensive notes taken on 
the features leading to any assessment of 
habitat quality so that changes over time can be 
assessed. 
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Conclusion 

This document has introduced some basic 
functions of QGIS, and how they can be used 
for habitat mapping and input into zoning 
methodology in the south and east 
Mediterranean region.  

In this region, an absence of any formal or 
available country level habitat or vegetation 
mapping hinders concrete habitat and species 
level zoning plans within Important Plant Areas. 
The following methods have been proposed 
and described to remedy or alleviate this issue: 

 Creating polygons and using them to 
delineate habitat zones based upon 
satellite imagery and expert knowledge. 

 Creating Potential Natural Vegetation map, 
and then compare them with satellite 
images and check the existence and 
quality of habitats. 

 Incorporating species occurrence data and 
the ability to compare amongst habitat 
zones 

 The use and incorporation of field survey 
data to improve the two habitat mapping 
methods (using satellite image and PNV), 
assess the quality and threats of habitat or 
increase the amount of data on species. 

 Outline the use of spatial data in 
management zoning and providing 
examples of how such data can be used to 
achieve management objectives, 
depending on the requirements of the 
responsible authorities. 
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Glossary 
Attribute: Data contained within a vector layer that can be displayed, classified and manipulated 

through the attributes table. These non-spatial characteristics of the entities, they are 
also called properties. They are supported in attribute tables of a data layer. 

CSV: Comma Separated Value (.csv). This is a standard spreadsheet file type for storing 
information in columns. 

DAFOR: Abundance scale for recording the relative occurrence of plant species in vegetation 
surveys. D = Dominant. A = Abundant. F = Frequent. O = Occasional. R = Rare. 

Feature: The concept of spatial feature refers to the vector layer. These features can be points, 
lines or surfaces and are determined by their contours by coordinates (x, y). In raster 
spatial features are all identical cells of a grid. In our case, the features will represent 
units of conservation interest within IPA (e.g. habitat, the point of occurrence of 
threatened and endemic species). 

Habitat: The term “habitat” used within this document refers to a homogeneous biological 
community / vegetation supported by common environmental conditions. 

IPA: Important Plant Area. 

Layer: In GIS, data are organized in the form of overlapping layers, each of which bring 
together similar features. Layers can be viewed individually or together, and data 
contained within them used in comparative mapping and analyses. 

Polygon: A polygon is a shape bounded by three or more sides. Regular polygons are named 
for their number of sides (for example triangle, square). Polygons are drawn to 
encompass spatial features in GIS applications, in this case corresponding to habitat 
or vegetation areas. 

Plugin: A plugin is an additional piece of software that can be added to QGIS to give 
additional functions. 

Raster data:  A representation of the world as a surface divided into a regular grid of cells. Raster 
models are useful for storing data that varies continuously, as in an aerial photograph, 
a satellite image, or an elevation surface. 

Shapefile: A standard file format (.shp) for vector layers in GIS applications. 

Vector data:  A representation of the world using points, lines, and polygons. Vector models are 
useful for storing data that has discrete boundaries, such as country borders, land 
parcels, and streets. 

Zoning: The concept of zoning in conservation management is used to define sub-units that 
may contain different features (for example habitats, species), or that might be of 
different quality (degraded or not), or that might require different management options 
or restricted activities for the conservation of features. These different “zones” may be 
treated differently and as distinct management units in management plans.  
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Annex I: Additional Information 

It is recommended to read the information about: 

The Print Composer; to create nice maps and atlases that can be printed or saved as PDF-file or an 
image, include legends etc.: 

http://docs.qgis.org/2.8/en/docs/user_manual/print_composer/print_composer.html 

The Vector Properties Dialog; it provides information about the layer, can be used to modify symbology 
settings and labelling options: 

http://docs.qgis.org/2.8/en/docs/user_manual/working_with_vector/vector_properties.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://docs.qgis.org/2.8/en/docs/user_manual/print_composer/print_composer.html
http://docs.qgis.org/2.8/en/docs/user_manual/working_with_vector/vector_properties.html
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Annexe II: Example of simple survey form 

Country: IPA:

Botanist 1 Botanist 2

Name First name Name First name

Date

Unique survey 

number 

Size of the record (KM2)

Panorama

X

Coord. 

longitude

Picture / photo 

Y

Coord. latitude

Substrate

Vegetation Coverage

Trees D (dominant) >75%

Shrubs A (abundant) 51-75%

Herbs F (frequent) 26-50%

Outcrops O (occasional) 11-25%

Rocks R (rare) <10%

Bare soils

DAFOR DAFORSpecies

Vegetation survey

Comments

Species

Habitat:

Disturbance

Dafor Scale

Coordinate system (e.g.WGS84):

Locality:

Geographical coordinates (GPS)


